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1 How to use this manual 

 

Please keep this manual for future reference! 

 

 

1.1 Technical terms 
 

All technical terms used in this manual are explained in the glossary at the end of the document. 

 

 

1.2 Formatting conventions 

 

 Terms used by the WirelessProfessional software are set in bold type, e.g. "The General tab is part of the tab bar with the General, 

Alarm List, Groups and Maps tabs." 

 Software buttons are displayed with a grey background in this manual, e.g. "Select Login and enter the installer password." 

 

 

1.3 WirelessProfessional software basics 

 

The WirelessProfessional software can be operated using a touchpad, a mouse or a touchscreen. 

 

 

1.3.1 Tabs 
 

Figure 1 shows the currently selected tab and the tab bar with the General, Alarm List, Groups and Maps tabs. The General tab is currently 

selected. In order to select a different tab, use the left mouse button to click on the tab in the tab bar or touch the tab on the touchscreen.  

 

 

 

 

 

 

  

Figure 1: General tab 
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1.3.2 How to select items 
 

To select a single item, click on it with the left mouse button or touch the item on the touchscreen (Figure 2). 

 

 

 

To select multiple non-consecutive items, press and hold down the Strg key and then individually click on the items you wish to select or touch 

them on the touchscreen (Figure 3). (The Strg-keys are located at the bottom left and bottom right of the keyboard (Ctrl-keys on keyboards 

with an English layout.) 

 

 
 

  

Figure 2: single selected item 

Figure 3: multiple non-consecutive selected items 
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To select multiple consecutive items, click on the first item or touch it on the touchscreen, press and hold down the Shift key and then click 

on the last item or touch it on the touchscreen (Figure 4). 

To select all items from a list, click inside the list with the left mouse button or touch the touchscreen within the list and then press the Ctrl+A 

keys together.  

Not all tabs in the WirelessProfessional software support all methods mentioned to select items. 

 

 

1.3.3 How to drag items 
 

To drag items, select the items you want to drag, then click on the selected items with the left mouse button and hold the mouse button down. 

Drag the items to their new location and release the mouse button. 

To drag items using the touchscreen, touch the selected items and move them to their desired location using your finger, (Figure 5) then 

remove your finger from the screen. 

 

 

  

Figure 4: multiple consecutive selected items 

 

Figure 5: Dragging multiple items 
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1.3.4 Context menu 
 

To open an item’s context menu, click on the item with the right mouse button (Figure 6). 

To open an item’s context menu using the touchscreen, touch the item and hold your finger down until a small square is displayed. The context 

menu will open once you have removed your finger from the screen. 

 

 
 

Figure 6: devices context menu 
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2 Introduction to the WirelessProfessional system 

 

The WirelessProfessional system is an automatic test system (ATS) for emergency escape lighting. The system complies with EN 62034. 

Figure 7 shows the constitution of a WirelessProfessional system. The emergency luminaires as well as other devices set up a wireless network 

that is used to communicate with the automatic test system. The automatic test system is composed of a computer with the 

WirelessProfessional software (Figure 7  no. 4) and the USB-Koordinator (Figure 7  no. 3). The USB-Koordinator links up the computer with 

the wireless network. The wireless network’s frequency is 868 MHz. 

    

 

 

Each device within the wireless network can communicate with other devices within its range (Figure 7 no. 1). The minimum range of 

WirelessProfessional devices is 30 m inside of buildings. The range can be larger depending on the attenuation in the building. 

In order for data to be transmitted between adjacent devices, a device must be located within the range of the other. All devices must be 

linked with the automatic test system by a chain of devices that are in range and can pass on data. Figure 8 shows a system with a broken 

connection to the three devices shown in red. All other devices in the figure are linked with the automatic test system by chains of devices that 

are in range and can thus communicate with the ATS. 

 

1 2 3 4 5 6 

1 Transmission range 

2 Maintained emergency luminaire 

3 USB-Koordinator 

4 Computer 

5 Repeater 

6 IO-box 

 

Figure 7: Constitution of a WirelessProfessional system 
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Table 1 lists devices that are available for WirelessProfessional systems. Only the devices listed here can be used in WirelessProfessional 

systems. 

 

Table 1: devices for WirelessProfessional systems 

Device Function 

Maintained emergency luminaire Luminaire in which the illuminant is lit at all times when normal or emergency lighting is 

required 

Non-maintained emergency luminaire Luminaire in which the illuminant is lit only in operation when the mains power supply to 

the general lighting fails 

IO-Box Device with digital inputs/outputs. The device can switch outputs according to system 

status and external sources can trigger system functions 

Repeater Used to bridge the gap between two devices if the devices are out of range 

 

Every WirelessProfessional device has a unique alphanumeric four-digit address. The address is marked on all WirelessProfessional devices. 

In a WirelessProfessional system the address is used to identify a device and to relate the installation location. A WirelessProfessional system 

can comprise up to 1000 devices. A larger number of devices can be split up into multiple WirelessProfessional systems. 

 

2.1 Start-up after a supply failure 

In the event of a supply failure the emergency luminaires change over to emergency mode.  After the supply is restored, the computer must be 

restarted with the on/off-button in order to put the automatic test system back into operation. Login to the user account and the 

WirelessProfessional Software will start up automatically. 

 

2.2 Conducting a duration test 
 

A duration test of the WirelessProfessional emergency luminaires can only take place if the last supply interruption (supply failure, fuse failure, 

duration test) was at least 20 hours ago. 

2.3 Processor-controlled emergency luminaires 

The battery charge in several WirelessProfessional emergency luminaires is controlled via a microprocessor. If the battery is not charged 

according to the required end of charging voltage, a functional or duration test cannot take place. Luminaires with this feature are described 

as “processor-controlled emergency luminaires” or as luminaires with “integrated SelfControl monitoring” in the respective attached 

instructions. 

Figure 8: devices connected to the ATS (green) and disconnected devices (red) 
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3 Installation 

3.1 Prior to automatic test system start-up 

Prior to start-up of the automatic test system, all emergency luminaires and other devices should be assembled in the building and their 

addresses should be registered in the floor plan. For this you can use the 3rd address label, which is included in each device. All devices that 

will be added to the WirelessProfessional system must be mains-operated during system setup. 

EN 62034 requires a complete duration test to be carried out at automatic test system start-up. The emergency luminaire batteries must be 

fully charged (for a minimum of 20 hours) in order for the duration test to take place. Ensure that all the emergency luminaires have been 

mains-operated for at least 20 hours before the first duration test on the automatic test system is started. 

3.2 Operation of the WirelessProfessional software 

If you are not familiar with operating the WirelessProfessional software, it is essential that you read section 1.3 concerning the basics of 

operating the software before start-up begins.   

3.3 Computer and USB-Coordinator connection 

 Connect the computers power supply to an outlet and connect the computer to the power supply. 

 Connect the USB-Coordinator to an unused USB port. 

Important: Use the USB cable included in the delivery to connect the USB-Coordinator with the computer. Do not connect the USB-

Coordinator via an USB hub. 

 Start the computer with the on/off button. 

 

Login to the Windows user account and start-up of the WirelessProfessional software take place automatically. The software will connect to 

the USB-Coordinator and the text in the title bar changes from [not connected] to [connected and running]. If the software does not connect 

to the USB-Coordinator automatically, a manual setup of the serial port as described in the following section is necessary. 

 

At the top left of the screen, click Options and then Seriel Port or click the index tab Installation and then System. Here you can reach the 

selection menu of the serial interface via the button Serial Port.  

 

 
Figure 9: Selection menu Serial Port via Options 

 

In the following windows click on the black arrow to open the selection menu, choose USB Serial Port and confirm your selection with OK. 

Afterwards, the title bar of the application window should have changed to [connected and running]. 

 

Note: The correct selection of COMx depends on the USB slot where the USB-Koordinator is plugged in. 

 

 
Figure 10: Select the Serial Port 
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3.4 Changing the password 

 Press Login and enter the installer password. The installer password is factory-set to 2222. 

 Select the Installation tab. Select the System tab from the lower tab bar. Click the Change Installer Password button. 

 

 
Figure 11: Change password 

 Enter the factory-set installer password. Enter a new password, re-enter the new password. Write down the new password. 

 
Figure 12: Enter password 

 

3.5 Entering contact details and the system name 
 

 Enter your contact details into the First Name, Last Name, Company, Phone and Email fields. 

 Fill in the System Name field. 

 Click on Save System Data to complete the setup. 
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3.6 Registering devices in the system 
 

 Select the Installation tab. Select the Configure Groups tab from the lower tab bar. The Unknown nodes section shows the devices that 

are connected to the automatic test system, but are not yet registered in the system. Make sure that all devices installed in the building 

are connected to the power supply and wait until all the devices are listed in the Unknown nodes section. 

 

 
Figure 13: Available devices 

 

Note: Devices with a radio module beginning with version 2.0 using a changed procedure to register devices. If not all devices are shown up 

in Unknown nodes use the button Find New Devices…  to start a new search. 

 

 
Figure 14: Find New Devices 

 

Confirm with OK to find new devices on your system. 
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 To register all devices in the system, click into the Unknown nodes section, select all devices and drag them into the Registered nodes 

section. 

Caution! During registration of the devices in the system, the USB-Koordinator should be positioned such that less than 50 devices are in 

direct range of it (refer to section 0, Network Information tab). 

 
Figure 15: Mark available devices 

Note: If not all the devices in the Unknown nodes section are to be registered in the system: Hold down the Ctrl key and select the devices you 

want to register in the system by clicking on them. Drag the selected devices into the Installed nodes section. 

 The WirelessProfessional software will now register the devices in the system. The first row in the Unknown nodes section shows the 

number of devices that are still to be registered (x devices not associated). The time needed to register the devices into the system varies 

according to the layout of the devices in the wireless network and the progress of the registration process. The time for registration can 

vary from seconds to minutes for a single device. 

 
Figure 16: Associate available devices 
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 After all devices have been successfully registered in the system, the first row in the Registered nodes section shows the number of 

emergency luminaires, repeaters and IO-boxes registered in the system. 

 

Figure 17: Devices successfully associated 

 To change the name of a registered device, open the context menu of the device in the Registered nodes section and select 

Rename ’LuminaireXXX’. 

 
Figure 18: Rename devices 

 To change a luminaire’s mode of operation between maintained and non-maintained, open the luminaire's Device Details window 

in the Registered nodes section by double-clicking with the left mouse button on the name of the luminaire or by touching the name 

twice (see also section 0). 

 Click on Save System Data to complete the registration of the devices in the system. 
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3.7 Dividing devices into groups 
 

1. If you wish to divide the devices into several groups, open the system's context menu (first row in the Registered nodes section) and 

select Add group to ’<system>’. 

 

 
Figure 19: Add a group 

2. Enter the group’s name in the Add New Group to ’<system>’ window and click on OK. 

 
Figure 20: Group name 

The new group will be added to the list in the Registered nodes section. This list is sorted into alphabetical order which may mean that 

the added group is not shown in the list’s section currently displayed. 

3. Press and hold down the Ctrl key and select all devices from the list that you want to add to the new group. Drag the selected devices 

into the new group. If the new group is not shown in the list’s section currently displayed, drag the selected elements to the upper or 

lower border of the Registered nodes section in order to scroll through the list. 
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Figure 21: Devide devices into groups 

4. Repeat steps 1 – 3 until all devices are divided into groups. 

5. Click on Save System Data to complete the division of the devices into groups.  
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3.8 Floor plans 

Floor plans can be loaded into the WirelessProfessional software and the registered devices can be placed on the floor plans. In this way the 

device’s installation location can be identified in the software. The floor plans must be in .png, .bmp or .jpg format. The maximum size of the 

floor plan is 10 megapixels. Floor plans larger than this cannot be loaded into the WirelessProfessional system. 

 

 

3.8.1 Loading floor plans 
 

1. Select the Maps tab. 

 

Figure 22: Maps general 

 

2. Open the context menu in the Maps in system section and select Add New Map. 

 

Figure 23: Add new map 
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3. Select the storage medium your floor plans are stored on in the Select a Map Image dialogue window. Select all the floor plans you wish 

to add and click on Open. 

 
Figure 24: Choose floor plan 

4. Open the context menu of one of the added floor plans and select Rename Map ’<name>’. 

 
Figure 25: Rename floor plan 

5. Enter a meaningful name for the floor plan and click on OK. 

6. Repeat steps 4 and 5 for all the floor plans.  
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3.8.2 Placing devices on the floor plans 
 

 Click on Toggle Map View. 

 

Figure 26: Toggle map view 

1. Select the floor plan you wish to place devices on from the drop-down list. 

 
Figure 27: Select floor plan 
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2. Use the slider to adjust the magnification and use the scroll bars to select the displayed floor plan detail. 

 
Figure 28: Scale view 

 

3. Drag the devices from the left section and place them on the floor plan. 

 

Figure 29: Place device 

 

4. Repeat steps 1 – 3 until all the devices are placed on the floor plans. 

5. Click on Save System Data to complete placing the devices on the floor plans. 

 

Note:  Any luminaire or device can’t be place multiple times. 
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3.9 Automatic test setup 

 Select the Installation tab. Select the Test tab from the lower tab bar. 

 Select the test interval for duration tests from the drop-down list Interval in the Capacity test section. EN 62034 requires a maximum 

interval of one year between automatic duration tests. 

 Enter the duration test’s start time in the Time field. Pick a time when the building is not occupied. If the building can be occupied at any 

time, EN 62034 allows a manual initiation of the duration test. In this case, select Manually from the Interval drop-down list. 

 Select a date for the next duration test from the calendar. The date should not be more than one year ahead. 

 Likewise, select the test interval for functional tests from the drop-down list Interval in the Function test section. EN 62034 requires a 

maximum time interval of one month between automatic functional tests. 

 If the selected test interval is Weekly, choose a day for the functional test from the Weekday drop-down list. 

 Click on Save System Data to complete the automatic test setup. 

 

 
Figure 30: Timer configuration 
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3.10 Duration test at initial start-up 

 

EN 62034 requires a complete duration test to be carried out at automatic test system start-up. The emergency luminaire batteries must be 

fully charged (for a minimum of 24 hours) in order for the duration test to take place (refer to sections 2.2 and 2.3). 

 Select the General tab. 

 Click on the Start Capacity Test button. 

 

In the event of battery failure, repeat the duration test after a second charging cycle (min. 24h).  

 

 

Figure 31: Start capacity test 
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4 Software installation 

This section applies to systems delivered without a computer. On systems delivered with a computer, the WirelessProfessional software is 

preinstalled. 

 

 

4.1 System requirements 

Component Minimum requirement 

Processor Intel Atom N455 1,6 GHz 

RAM 1024 MB DDR3-RAM  

HDD 32 GB SSD 

Display 25,7 cm (10,1") screen diagonal, 1024x600 pixel resolution 

Graphics Intel GMA 3150 

Ports 2 x USB 2.0 

Operating system Windows 7, 32- or 64 bit 

 

4.2 Installation 

 

 Open the WirelessProfessional_Setup_x.x.exe file's context menu (x.x is the software version) and select Run as administrator to start 

the installation process. 

 

 
Figure 32: Choose the installation file 
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 Enter the password for the administrator account in the user account control dialogue window and click on Yes. 

 

 
Figure 33: Enter administrator password 

 Select the language to be used for the software setup and click on OK. 

 

 
Figure 34: Select a language 

 Click on Next in the setup wizard window. 

 

 
Figure 35: Setup dialog 

 Read the information regarding the installation folder and click on Next. 

 

 
Figure 36: Setup dialog 

 

 Change the start menu folder’s name if you wish to and click on Next. 
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Figure 37: Setup dialog 

 Select Create a desktop icon if you wish to and click on Next. 

 
Figure 38: Setup dialog 

 Click on Install. The software and all necessary drivers will be installed. 

 
Figure 39: Setup dialog 

 Click on Finish to complete the setup wizard. The WirelessProfessional software will be started. 

 
Figure 40: Complete Installation 

 

Note: The CPC Viewer and CPC Filemanager programs are required if remote access to a remote system is to be established. 
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5 Software reference 
5.1 Symbols 

 

This section explains the symbols used in the WirelessProfessional software. 

Table 2 shows the colour symbols and the status they indicate. If more than one status applies to a device or a group, the highest priority 

status colour symbol will be displayed. If for example a group is comprised of emergency luminaires with errors (red symbol, priority 3) and 

the luminaires in this group are currently being tested (blue symbol, priority 4), the blue symbol will be displayed because of its higher priority. 

Exceptions to this rule are communication errors that occur during a test: a red symbol is shown in this case to draw attention to the error. 

Symbol  Priority Status 

 Yellow 5 Status is being updated 

 Blue 4 Emergency luminaire is tested 

 Red 31 Error(s) 

 Orange 2 Remote inhibiting mode 

 Green 1 No errors 

 Grey - Emergency luminaire is masked 

1 Communication errors that occur during a test are displayed with higher priority than the test. 

Table 2: colour symbols 

 

5.1.1 Operating mode symbols 

Symbol Operating mode 

 Maintained emergency luminaire 

 Non-maintained emergency luminaire 

 
Maintained emergency luminaire: emergency lighting illuminant is on 

Non-maintained emergency luminaire: emergency lighting illuminant is off 

 
Maintained emergency luminaire: emergency lighting illuminant is off 

Non-maintained emergency luminaire: emergency lighting illuminant is on 

 Group/system is linked with the input/output of an IO-box 

 Group/system is linked with a timer 

Table 3: operating mode symbols 

 

5.2 Operating modes 

 

Table 4 shows an overview of operating modes. The operating modes are explained in detail in the glossary (section 9). 

Operating mode Non-maintained 

emergency luminaires1 

Maintained luminaires1 Functional/ 

Duration test 

Emergency 

mode 

Energy Save Off Off Yes Yes 

Activate Off1 On Yes Yes 

Fire alarm On On No Yes 

Remote inhibiting mode Off Off No No 
1The Activate function does not toggle switchable non-maintained emergency luminaires. Luminaires that are turned off stay off and 

luminaires that are turned on stay on. 

Table 4: operating modes 
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5.3 Status messages 

 

Table 5 lists and explains the status messages of the WirelessProfessional software. 

Status message  

Starting system Communication with all devices is checked 

Updating Message is shown while a device status is updated 

Device not associated Device is still to be registered in the system 

Blocking x luminaires x luminaires are still to be set to remote inhibiting mode 

Unblocking x luminaires Remote inhibiting mode is still to be terminated on x luminaires 

Emergency state is expiring The follow-up time has passed and the emergency luminaires are being turned off 

Operational At least one switchable emergency luminaire is turned on 

Ready to activate All switchable emergency luminaires are turned off OR the system is only comprised of non-switchable 

emergency luminaires. 

Error on x devices Error messages for x devices have accumulated 

Emergency state is activated 

by IO-box 

Fire alarm at the fire alarm input of an IO-box. All switchable emergency luminaires are turned on. 

Emergency state is in follow-

up time 

The fire alarm has ended. The follow-up time is running. Switchable emergency luminaires stay turned 

on until the end of the follow-up time. 

Starting test on x devices A test on x devices is being started 

Test running Status message while a test is running 

Finishing test on x devices A test has finished and the results are being transmitted from the emergency luminaires 

x luminaires are blocked x emergency luminaires are in remote inhibiting mode 

Table 5: status messages 
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5.4 Error messages 

Table 6 lists, explains and gives possible causes for the error messages of the WirelessProfessional software. 

Error message  Possible causes 

Device invalid The device has an unknown device type ID  The device firmware is more up to date than 

the WirelessProfessional software 

Connection lost The wireless communication with a device is 

broken 
 Device operates in emergency mode 

 Radio transmission failure 

Battery error The battery voltage is out of range  Battery is not connected 

 Wrong battery type connected 

 Battery deeply discharged 

 Battery damaged 

Last test failed: connection error The wireless connection was broken while testing 

or after the test had finished 
 Wireless communication error 

Last test failed: battery error Battery error while testing  Battery is not connected 

 Wrong battery type connected 

 Battery was not fully charged  

 Battery deeply discharged 

 Battery damaged 

Last test failed: illuminant error Illuminant failure while testing  Illuminant not connected 

 Defective illuminant 

 Defective changeover device 

 Illuminant current too small 

Table 6: Error messages 

5.5 User levels 

Access rights to functions of the WirelessProfessional system are divided into several user levels. Table 7 lists the user levels and their specific 

access rights. The facility manager, installer and distributor user levels are password protected against unauthorised access. The 

WirelessProfessional software starts with the anybody user level. 

User level Access rights 

Anybody Read only, no authorisation to make changes 

Facility manager Switch devices, initiate functional/duration tests 

Installer Register devices, define groups and automatic tests, add floor 

plans, reset facility manager password 

Distributor Set service interval, reset the installer password, change logo 

Table 7: user levels and their access rights 

  



 

 

 

 

 

 

WirelessProfessional 
 

 

Setup and Operation Manual 

Page 26 

5.6 General tab 

To view the General tab, click on the General tab in the tab bar. 

The General tab shows the system’s name, the number of groups in the system and the system’s status. Fig. 9 shows the General tab on the 

facility manager or installer user level. On the anybody user level, the buttons Activate, Energy Save, Block Luminaires etc. are missing. 

Section 5.1 describes the colour symbols in the Status column. If a red symbol indicates that error messages have accumulated, the Alarm 

List tab can be opened with a click with the left mouse button or a touch on the red colour symbol. Clicking into or touching the No. Groups 

opens the Groups tab. 

 

Table 8 lists the functions that can be accessed from the General tab with the buttons. 

Button Function User level 

Activate Turns all switchable maintained emergency luminaires on Facility manager, installer 

Energy Save Turns all switchable emergency luminaires off Facility manager, installer 

Block luminaires Switches all emergency luminaires into remote inhibiting mode Facility manager, installer 

Logout Sets the user level back to anybody Facility manager, installer 

Start Function Test Starts a functional test on all emergency luminaires Facility manager, installer 

Start Capacity Test Starts a duration test on all emergency luminaires Facility manager, installer 

Retract Emergency Follow-

Up 

Terminates the follow-up time after a fire alarm. This button is only 

active when a fire alarm has been detected and the follow-up time is 

running. 

Facility manager, installer 

Table 8: functions accessible from the General tab 

 

Note: With a manual logout, the query appears asking if the system should be saved. With automatic logout this happens without query. 

 

 
Figure 42:Save the system dialog 

 

  

Figure 41: General tab, facility manager or installer user level 
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5.7 Alarm List tab 
 

To view the Alarm List tab, click on the Alarm List tab in the tab bar. 

The Alarm List tab shows all devices that report an error. The defective devices are arranged into groups. The alarm shows the device’s name, 

its address and its status (colour symbol and plain text). Section 5.4 describes the colour symbols in the Status column. Section 5.4 gives an 

overview of the WirelessProfessional system’s error messages. Figure 43 shows the Alarm List tab on the facility manager or installer user 

level. On the anybody user level, not all of the shown buttons are available. 

 

The error list's context menu (Figure 43) offers the functions listed in Table 9. 

 

Note: You can select one or more devices at the same time. Instructions for multiple selecting can be found in the section 

1.3.2. 

 

Table 9: functions of the error list context menu 

 
The emergency luminaire batteries must be fully charged in order for a functional or duration test to take place (refer to sections 2.2 and 2.3). 

  

Menu item Function User level 

Start function test for luminaire 

’<name>’ 

Starts a functional test on this emergency luminaire Facility manager, installer 

Start capacity test for luminaire 

’<name>’ 

Starts a duration test on this emergency luminaire Facility manager, installer 

Block luminaire ’<name>’ Turns this luminaire into remote inhibiting mode Installer 

Deblock Terminates the remote inhibiting mode Installer 

Show on map Shows the emergency luminaire on the floor plan Anybody 

Figure 43: Alarm List tab, facility manager or installer user level 
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Table 10 lists the functions that can be accessed from the Alarm List tab with the buttons. 

 

Button Function User level 

Inspection Log Opens the inspection log (see section 5.7.1) Anybody 

Operation Time Log Not implemented Anybody 

Communications Log Opens the communications log (see section 0) Anybody 

System Log Opens the system log (see section 5.7.3) Anybody 

Start Function Test Starts a functional test on all emergency luminaires Facility manager, installer 

Start Capacity Test Starts a duration test on all emergency luminaires Facility manager, installer 

Logout Sets the user level back to anybody Facility manager, installer 

Table 10: functions accessible from the Alarm List tab 

 
The emergency luminaire batteries must be fully charged in order for a functional or duration test to take place (refer to sections 2.2 and 2.3). 

 

 

5.7.1 Inspection log 

The inspection log records the results from functional and duration tests as well as other messages. The inspection log is opened with the 

Inspection Log button on the Alarm List tab. Figure 44 shows a screenshot of the inspection log.  

 

 

 
 

The inspection log is stored in the inspection_log.txt file. If the size of this file exceeds 4 MB, the file name is changed to 

inspection_log_<date>.txt and a new inspection_log.txt file is created. 

Table 11 lists the functions that can be accessed from the Inspection Log with the buttons. 

 

Button Function User level 

Copy to clipboard Copies the selected entry to the clipboard Anybody 

Add message Enter a message manually. After the message has been entered, click on the 

Refresh button to display the new entry in the log. Messages entered in the log 

cannot be deleted. 

Anybody 

Open old log Opens an archived inspection log Anybody 

Refresh Updates the log window Anybody 

OK Closes the Inspection Log window Anybody 

Table 11: functions accessible from the inspection log 

  

Figure 44: Inspection Log 
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5.7.2 Communications log 
 

The communications log records messages from the wireless network. Other events stored in the communications log include the start date 

of the WirelessProfessional software and the USB-Koordinator connection. Figure 45 shows a screenshot of the communications log. 

 

 

The communications log is stored in the communication.log file. If the size of this file exceeds 4 MB, the file name is changed to 

communication_<date>.log and a new communication.log file is created. 

Table 12 lists the functions that can be accessed from the Communications Log with the buttons. 

Button Function User level 

Copy to clipboard Copies the selected entry to the clipboard Anybody 

Open old log Open an archived inspection log Anybody 

Refresh Updates the log window Anybody 

OK Closes the Communications Log window Anybody 

Table 12: functions accessible from the communications log 

 

5.7.3 System log 
 

The system log records all the system configuration and status changes. Figure 46 shows a screenshot of the system log. 

 

 

The system log is stored in the system.log file. If the size of this file exceeds 4 MB, the file name is changed to system_<date>.log and a new 

system.log file is created. 

Table 13 lists the functions that can be accessed from the System Log with the buttons. 

  

Figure 45: Communications log 

Figure 46: System log 
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Button Function User level 

Copy to clipboard Copies the selected entry to the clipboard Anybody 

Open old log Opens an archived inspection log Anybody 

Refresh Updates the log window Anybody 

OK Closes the System Log window Anybody 

Table 13: functions accessible from the system log 

 

 

5.8 Groups tab 

 

To view the Groups tab, click on the Groups tab in the tab bar. 

The Groups tab shows the groups in the system and the devices within each group. Figure 47 shows a screenshot of the groups tab. 

 

 

The upper section in the groups tab shows the groups in the system. The columns show the group’s name, its status and the number of 

emergency luminaires, repeaters and IO-boxes. Section 5.1 describes the colour symbols in the Status column. The OnOff buttons in the 

columns Maintained Luminaires and Non-maintained Luminaires allow the luminaires to be turned on or off. This function is only available 

on the facility manager and the installer user levels and only if switchable emergency luminaires are present in the system. A red frame around 

the OnOff button indicates a non-maintained emergency luminaire that is turned on or a maintained emergency luminaire that is turned off. 

  

Figure 47: Groups tab, facility manager or installer user level 
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The group list's context menu (Figure 47 offers the functions listed in Table 14. The functions affect all luminaires within the group. 

 

Menu item  Function User level 

Start function test for group ’<name>’ Starts a functional test for all emergency 

luminaires in this group 

Facility manager, installer 

Start capacity test for group ’<name>’ Starts a duration test for all emergency 

luminaires in this group 

Facility manager, installer 

Block group ’<name>’ Turns all emergency luminaires in this 

group into remote inhibiting mode 

Facility manager, installer 

Deblock Terminates the remote inhibiting mode Facility manager, installer 

Table 14: group list context menu 

 
The emergency luminaire batteries must be fully charged in order for a functional or duration test to take place (refer to sections 2.2 and 2.3). 

The lower section in the Groups tab shows the devices in the group that is selected in the upper section (see Figure 48). The lower section 

shows the device name, its address, status, the operation mode, its position and the device type. The OnOff buttons in the Switch Luminaires 

column allow the luminaires to be turned on or off. This function is only available on the facility manager and the installer user levels and only 

if the emergency luminaires are switchable. A red frame around the OnOff button indicates a non-maintained emergency luminaire that is 

turned on or a maintained emergency luminaire that is turned off. 

 

 

 

  

Figure 48: Groups tab, facility manager or installer user level 
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The devices' context menu (Figure 48) offers the functions listed in Table 15.  

 

Note: You can select one or more devices at the same time. Instructions for multiple selecting can be found in the section 

1.3.2. 

 

Table 15: device list context menu 

 
The emergency luminaire batteries must be fully charged in order for a functional or duration test to take place (refer to sections 2.2 and 2.3). 

 

 

5.9 Maps tab 
 

To view the Maps tab, click on the Maps tab in the tab bar. 

The Maps tab allows floor plans to be added and emergency luminaires that are registered in the system to be placed on the floor plans, so 

that the installation location of a device can be looked up at any time. The functions of the Maps tab can only be used on the installer user 

level. On the anybody and facility manager user levels, the floor plans can only be viewed. 

 

 
 

The maps tab has two views: the list of floor plans (view 1, Figure 49 and the view on the floor plan with the luminaires placed (view 2, Figure 

51). You can switch between these two views with the Toggle Map View button. 

 

 

  

Menu item Function User level 

Start function test for luminaire 

’<name>’ 

Starts a functional test on this emergency luminaire Facility manager, installer 

Start capacity test for luminaire 

’<name>’ 

Starts a duration test on this emergency luminaire Facility manager, installer 

Block luminaire ’<name>’ Turns this luminaire into remote inhibiting mode Facility manager, installer 

Deblock Terminates the remote inhibiting mode Facility manager, installer 

Show on map Shows the emergency luminaire on the floor plan Anybody 

Figure 49: Maps tab, installer user level 
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5.9.1 Maps tab, view 1 
 

To add a floor plan, open the context menu in the Maps in system section (Figure 49) and select Add new map. Select the storage medium 

your floor plans are stored on in the Select a Map Image dialogue. Select all the floor plans you wish to add and complete the selection with 

Open. The floor plans must be in .png, .bmp or .jpg format. The maximum floor plan size is 10 megapixels. Larger floor plans cannot be loaded 

in the WirelessProfessional system. 

You can drag a floor plan to a new position within the list in order to rearrange the list. 

The context menu of the floor plans in the Maps in system section offers the functions Add new map, Rename map ’<name>’, Delete map 

’<name>’ and Switch to Map View of ’<name>’.  

Open the context menu on the right section of the Maps tab and select Add new building logo to add a picture of the building. Select the 

storage medium the picture is stored on in the Select a Building Logo dialogue. Select the picture and complete the selection with Open. The 

picture must be in .png, .bmp or .jpg format. 

Double click or touch twice on an entry in the list of floor plans to open it and change to view 2. 

If you make any changes to the floor plans, select  Save System Data to save the changes. 

 

 

 
 

 

 

 

 

 

  

Figure 50: Maps tab, installer user level 
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5.9.2 Maps tab, view 2 
 

 

View 2 of the maps tab allows the registered luminaires to be placed on the floor plans. Figure 51 shows a screenshot of the maps tab in view 

2.  

To change to view 2, click on the Toggle Map View button or double click/touch twice on an entry in the list of floor plans. 

The left section shows the groups and devices of the system. To place a device on the floor plan, select the device in the left section and drag 

it to the location it is installed at on the floor plan. Devices placed on the floor plan will automatically be removed from the left section.  

The floor plan currently displayed can either be selected in the drop-down list above the floor plan or with the arrow buttons located to the left 

and right of the drop-down list.  

Use the slider to adjust the magnification and use the scroll bars to control the displayed floor plan detail. 

 

 
 

Table 16 lists the functions that can be accessed with the buttons in view 2 of the Maps tab. 

Button Function User level 

Reset Node Positions Removes all devices from the floor plan Installer 

Toggle Map View Changes between view 1 and view 2 Anybody 

Save System Data Saves changes Installer 

Table 16: functions in view 2 of the maps tab 

 

If you make any changes in the Maps tab, select Save System Data to save the changes. 

  

Figure 51: Maps tab, installer user level 
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5.10 Email tab 
 

 

To view the Email tab, click on the Email tab in the tab bar. The Email tab is only available on facility manager and installer user levels. 

 

 

The WirelessProfessional software offers the option to send an email to a predetermined address if certain events take place. To use this 

function, you need an email account to send the emails from and the computer must be connected to the internet. Figure 52 shows a 

screenshot of the email tab.  

Figure 52: Email tab, facility manager or installer user level 
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Table 17 lists the fields on the email tab and explains their function. 

Field Function 

Sender Sender email address 

Subject Entry in the email’s subject field 

Email address Receiver email address. If the email should be sent to multiple receivers, separate the addresses with a 

comma, e.g. receiver1@domain1.com, receiver2@domain2.com … 

SMTP server SMTP server the email is being sent from 

Port The port for the connection with the SMTP server (port 25, 587 or 465 in most cases) 

SMTP server login SMTP server login 

SMTP server password SMTP server password. Only SMTP servers with password authentication are supported by this software. 

Wait time Time taken from an event until an email is sent. If additional events occur during this time span, multiple 

events can be reported with one email. 

Radio fault Email is sent in the event of a radio fault 

Battery fault Email is sent in case of a battery fault 

Also report temporary faults Tick this box to have emails sent even if the fault is fixed before the wait time is over 

Mail delivery on function test You can choose from 

 email after all functional tests (all tests) 

 email after functional test with errors (failed tests) 

 never send an email after a functional test (never) 

Mail delivery on capacity test You can choose from 

 email after all duration tests (all tests) 

 email after duration test with errors (failed tests) 

 never send an email after a duration test (never) 

Blocking luminaire Send email if emergency luminaires are turned into remote inhibiting mode 

Emergency status change Send email if the fire alarm signal at an IO box input is turned on or off 

Installer login Send email if a user logs in as an installer 

Logout time Users logged in as facility manager or installer are automatically logged off after the logout time if no user 

activity is being detected during this time. This function’s purpose is to automatically log off users that 

forget to log of. 

Table 17: fields on the email tab 

 
Table 18 lists the functions that can be accessed with the buttons on the email tab 

Button Function User level 

Change facility manager password Change the facility manager password Facility manager, installer 

Send test email Send a test email Facility manager, installer 

Save System Data Save changes Facility manager, installer 

Table 18:  functions in the email tab 

 

If you make any changes in the email tab, click on Save System Data to save the changes. 
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5.11 Installation tab 

 

 

To view the Installation tab, click on the Installation tab in the tab bar. The Installation tab is only available on the installer user level.  

The Installation tab is subdivided into the Configure Groups, Test, Timer and System tabs. 

 

 

5.11.1 Configure Groups tab 
 

 

To view the Configure Groups tab, click on the Configure Groups tab in the lower tab bar on the Installation tab. 

New devices can be registered in the system and groups can be created and edited in the Configure Groups tab. Fig. 20 shows a screenshot 

of the Configure Groups tab. 

 

 

 
 

The first row in the Registered nodes section shows the name and the properties of the system. The system’s groups and the devices within 

the groups are shown below. Click on or touch the triangle to the left of a group to expand the group and show the devices within the group or 

click on the triangle again to close the group. 

The columns in the Registered nodes section show the group’s or the device’s name, the status and the number of emergency luminaires, 

repeaters and IO-boxes in the group. Section 5.1 describes the symbols in the Status column. 

The context menu of the Registered nodes section (Figure 54) offers the functions listed in Table 19. The entries in the context menu vary, 

depending on whether a group or a device is selected. 

Figure 53: Configure Groups tab, installer user level 
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Table 19:  context menu functions 

 
The emergency luminaire batteries must be fully charged in order for a functional or duration test to take place (refer to sections 2.2 and 2.3). 

The Unknown nodes section to the right shows devices, which are not registered in the system, but are in range of the wireless network. The 

list is divided into luminaires, repeaters and IO-Boxes. Devices that are not supported by the installed version of the WirelessProfessional 

software show up in the Unknown nodes section as Unknown Device. If a device’s wireless connection is broken for more than 15 minutes, 

the device will be removed from the Unknown nodes section. 

To register devices from the Unknown nodes section in the system, select the devices (Figure 55) and drag them onto the Registered nodes 

section. The devices will then be registered one after the other. The first row in the Registered nodes section shows the remaining number of 

devices to be registered. The registration time can vary from seconds to minutes for a single device. 

Menu item Function User level 

Mask x luminaires, x repeaters and x IO-

boxes/Mask luminaire ’<name>’ 

Devices will be masked (device errors will not be displayed) Installer 

Unmask Devices Removes the masking Installer 

Start function test for luminaire/group 

’<name>’ 

Starts a functional test for this luminaire /this group Installer 

Rename Luminaire/Group ’<name>’ Rename the luminaire / the group Installer 

Add group Adds a group to the selected group or the system. This function is 

available only if a group or the system is selected 

Installer 

Delete Luminaire/Group ’<name>’ Deletes the luminaire /the group from the system Installer 

Figure 54: Configure Groups tab, installer user level 
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Caution! During registration of the devices in the system, the USB-Koordinator should be positioned such that less than 50 devices are in 

direct range of it (refer to section 5.12, Network Information tab). 

Following registration in a system, devices will only forward the data packets in the wireless network that originate from the system they are 

registered in. If single devices are added individually to the system, the following situation can occur: If the single device that is supposed to 

be added to the system is located far away from the USB-Koordinator and the devices in between that are needed for the wireless 

communication are not yet registered in the system, then the device located far away cannot be accessed. For this reason devices should 

always be selected in the Unknown nodes section and dragged to the Installed nodes section together. 

The context menu of the entries in the unknown nodes section (Figure 56) offers the functions listed in Table 20. 

The Add New Luminaire, Add New Repeater and Add New IO-Box functions allow devices to be added manually to the Unknown nodes section 

without the need for a wireless connection. With this function, emergency luminaires can be registered in the system even if the installer is 

not located at the installation site or if the luminaires are not yet installed. The devices’ addresses must be known in order to add them 

manually. Just as normal devices, manually added devices can be registered in the system by dragging them into the Installed nodes section. 

The colour symbol for manually added devices stays yellow until a wireless connection with the device can be established and then it changes 

to green. 

  

Figure 55: Configure Groups tab, installer user level 
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Menu item Function User level 

Delete Device ’<name>’ Deletes the device from the Unknown nodes section Installer 

Add new Luminaire Adds an emergency luminaire manually Installer 

Add new Repeater Adds a repeater manually Installer 

Add new IO Box Adds an IO-Box manually Installer 

Table 20: context menu functions 

 

 

 

 

 

 

  

Figure 56: Configure Groups tab, installer user level 
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5.11.2    Test tab 
 

 

To view the Test tab, click on the Test tab in the lower tab bar on the Installation tab. 

 

 

 
 

The WirelessProfessional system carries out automatic tests of emergency escape lighting systems according to EN 50172 and EN 62034. 

The settings for the automatic functional test and the automatic duration test are on the Test tab. Figure 57 shows a screenshot of the Test 

tab. 

Table 21 lists the fields on the Capacity test section of the Test tab and explains their function. 

Field Function 

Interval Time interval for duration tests. Choose from Yearly, Half-Yearly, Every 4 Months and Quarterly. Choosing Manually 

turns automatic testing off. 

Time Time the duration test starts at. Select a time when the building is not occupied. 

Part 1 Not implemented 

Part 2 Not implemented 

Interval between 

parts 

Not implemented 

Start date Select a date for the next duration test 

Next capacity test The date for the next duration test is displayed after the setup is completed by clicking on Save System Data 

Table 21: fields on the Capacity test section of the Test tab 

 
The emergency luminaire batteries must be fully charged in order for a functional or duration test to take place (refer to sections 2.2 and 2.3). 

If an automatic duration test is started and one or more emergency luminaires are not sufficiently charged (refer to sections 2.2 and 2.3), the 

duration test for these luminaires will be postponed for 24 hours. After 24 hours a new duration test on these luminaires will take place. The 

software allows for a maximum of three attempts at a duration test on the emergency luminaires. 

 

  

Figure 57: Test tab, installer user level 
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Table 22 lists the fields on the Function test section of the Test tab and explains their function. 

Field Function 

Interval Time interval for functional tests. Choose from Daily, Weekly and Manually. Choosing Manually turns automatic 

testing off. 

Time Time at which the functional test starts. Select a time when the building is not occupied. 

Weekday Weekday on which the functional test is carried out. This field is only available if Weekly is chosen as the interval. 

Next function 

test 
The date for the next functional test is displayed after the setup is completed by clicking on Save System Data 

Table 22: fields on the Function test section of the Test tab 

 

If you make any changes in the Test tab, select  Save System Data to save the changes. 

 

 

5.11.3    Timer tab 
 

 

To view the Timer tab, click on the Timer tab in the lower tab bar on the Installation tab. 

Timers allow emergency luminaires to be switched automatically at a pre-set time. Figure 58 shows a screenshot of the Timer tab. 

 

 
 

Table 23 lists the functions that can be accessed from the Timer tab with the buttons. 

Button Function User level 

New Timer Opens the Configure Timer window (Figure 59) for a new timer Installer 

Edit Timer Opens the Configure Timer window (Figure 59) for the selected timer entry Installer 

Activate/Deactivate Timer Enables or disables the selected timer entry Installer 

Delete Timer Deletes the selected timer entry Installer 

Table 23: functions accessible on the Timer tab 

 
  

Figure 58: timer tab, installer user level 
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The buttons New Timer and Edit Timer open the Configure Timer window with the timer settings (Figure 59). Table 24 lists the fields in the 

Configure Timer window and explains their function. 

 

 

 
 

Field Function 

Name The timer’s name 

Start Date Date from which the timer is active 

End Date Date from which the timer is inactive 

Switch-On Time Time at which the emergency luminaires are switched on 

Switch-Off Time Time at which the emergency luminaires are switched off 

Days Select the days on which the timer should be active or select Daily 

Operating Mode Select the timer’s switching function. Select from: 

 Switch maintained emergency luminaires 

 Switch non-maintained emergency luminaires 

 Energy Save (turns all switchable emergency luminaires off) 

 Activate (turns all switchable maintained emergency luminaires on) 

 Function test (start a function test on selected groups) 

 Capacity test (start a capacity test on selected groups) 

Groups to switch Select the groups whose emergency luminaires are to be switched 

Table 24: fields in the Configure Timer window 

 

If you make any changes in the Timer tab, select Save System Data to save the changes. 

 

Note: For function and capacity testing, only the switch-on time must be set. Otherwise error message. 

 

 
Figure 60: Failure timer programming 

  

Figure 59: Configure Timer window 
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Timer-controlled function or capacity tests are recommended if small test groups are necessary. A manual test will perform on a selection of 

luminaires. 

Note: Two timers triggering the functional tests must be programmed with a 1h interval. 

 

 
Figure 61: Overview programmed timer 

By default the number of programmable timers is limited to 5 and can be extended by activation. For further information about system 

expansion, please contact your distributor. 

 

 

5.11.4    Remote Facilities 
 

 

To view the Remote Facilities tab, click on the Installation tab and in the lower tab bar on the Remote Facilities tab. 

The WirelessProfessional software is able to monitor other WirelessProfessional systems which are connected via Ethernet. 

 

 
Figure 62: remote facilities tab, installer user level 
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The New Remote Facility button opens the configuration menu for remote facilities. 

 

 
Figure 63: configuration remote facility 

 

 

Enter any name for the monitored system (p.e.: WLTOUCH 1st floor). In the input field “Remote computer” enter the ip address or device name 

of the respective system. By using the button Test connection you can check the connection to the remote system. 

If the connection to the remote system is successful ( ), configure the Update delay. With the Update delay you can set how often data is 

requested from the remote system. Here you can choose between 10 seconds, 1 minute and 10 minutes. 

With activated VNC access, it is possible to double-click or double-tap directly to the respective system 

build and operate it by remote control.  

Prerequisite for the remote connection is: 

-  The device to be monitored is running TigerVNC Server 

-  The TigerVNC Viewer is installed on the monitored device 

(Pre-installed or supplied as setup under c:\WirelessProfessional\CPC Tools\TigerVNC\windows\). 

If all configurations have been made, confirm with OK. 

 

Note: A remote device can be a multiControl plus series system, with XML version 1, or a WirelessProfessional system. In addition, the type of 

remote access is selectable. 

 

 
Figure 64: connection test remote computer 
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All monitored systems are listed with name, IP address and status. With the button Edit Remote Facility you can open the respective 

configuration menu and edit it again. With the button Delete Remote Facility it is possible to delete the respective system from monitoring. 

 

The file path of the VNC Viewer can be selected via the button at the bottom right. By default, the folder of the VNC viewer is C:\Program 

Files\TigerVNC. Select the vncviewer.exe and click on Open. If the installation path deviates from the standard path, select it accordingly. 

 

 
Figure 65: Overview remote facilities 

 

The number of monitored systems is limited to 1 by default and can be extended by activation (see 5.15). 

For further information about system expansion, please contact your distributor. 

 

 

In the General view, you now see not only the main system but also all systems to be monitored by the main system. 

 

 
Figure 66: monitorung remote facilitys 

 

By double-clicking or double-tapping in "No. Groups" or "Status" column of the corresponding system, the remote access to the respective 

system is established. 
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Figure 67: VNC client started 

 

Enter the password, which is “123456” by default and then click OK. 

 

 
Figure 68: VNC Client enter password 

 

In the window that opens, you have full access to the remote system. 

 

 
Figure 69: Access to the remote system 

5.11.5   System tab 
 

To view the System tab, click on the System tab in the lower tab bar on the Installation tab. 

The installer’s contact details are entered on the System tab. In addition several other settings that affect the overall emergency lighting 

system are located on the System tab. Figure 70 shows a screenshot of the System tab. 

 

Table 25 lists the fields in the System tab and explains their function. 

Field Function 

First Name, Last Name, Company, Phone, Email Installer’s contact details. These contact details are shown in the Maintenance Due 

reminder window. 

System Name Name for the system 

Project Name Name for the project 

Time to connection error Time span from a broken wireless connection until an error is reported. This setting 

applies to all devices except IO-Boxes. 

Time to connection error for IO boxes Time span from a broken wireless connection with an IO-Box until an error is reported. 

In addition to the error message, the IO-Box’s relay 1 (output K1) drops out. 

Emergency follow-up time Time from the end of a fire alarm until the emergency luminaires are turned off again. If 

Manual Retraction is chosen, the emergency follow-up time must be ended with the 

Retract Emergency Follow-Up button on the General tab.  

Commands waiting Number of commands that remain to be transmitted to a device 

Commands in execution Number of commands in the USB-Koordinators output buffer 

Table 25: fields on the System tab 
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The larger of the two time spans Time to connection error and Time to connection error for IO-Boxes determines the minimum time which the 

automatic test system displays the Status is being updated (colour symbol ) message at start-up. The system cannot change to the No 

errors (colour symbol ) status prior to this time span having passed because a connection error, that is present from start-up onwards, can 

only be reported after the time span Time to connection error has passed. 

 

 

 
 

After interrupting an installation or replacing the coordinator, the system ID must be reentered in all devices. Use herefor the button 

Reconnect all devices. During this process, the system allocation is temporarily deleted from the devices. These will still be displayed in the 

Registered Nodes section. Devices of other systems in range are temporarily displayed in the Unknown Nodes area. 

 

Attention: The Reconnect all devices function is also executed in all other systems in range. Due to the resulting high radio revenue, it may 

take several hours for this process to complete. If you made changes in the Configure Groups view, select Save system data to complete the 

changes. 

  

Figure 70: System tab, installer user level 
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Table 26 lists the functions that can be accessed from the System tab with the buttons. 

 

Button Function User level 

Serial Port Manually set the USB-Koordinator’s port Installer 

Change Installer Password Change the installer password Installer 

Reset Facility Manager Password Sets the facility manager password back to 1111 Installer 

Import Inspection Log Not implemented Installer 

Export Groups Exports the groups-structure in a file with csv (comma separated values) format Installer 

Table 26: functions accessible on the System tab 

 

If you make any changes in the System tab, select Save System Data to save the changes. 
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5.12 Network Information tab 
 

To view the Network Information tab, click on the Network Information tab in the tab bar. The Network Information tab is only available on the 

installer and distributor user levels. 

The upper section of the Network Information tab shows the wireless signal strength of the devices, which are in direct range of the USB-

Koordinator. In Figure 71, devices within direct range of the USB-Koordinator are marked. Figure 72 shows a screenshot of the Network 

Information tab. The size of the bars indicates the signal strength. The devices’ addresses are displayed above the bars. 

After the device’s signal strength has been measured, a two-minute timer is started. While the timer is running, the colour of the bar indicating 

the signal strength changes from green to grey. If the two-minute timer expires without a new signal strength value for the device being 

acquired, the device is removed from view. 

 
 

 

 

 
  

1 Device within direct range of the USB-Koordinator 

2 USB-Koordinator 

3 Computer 

4 Device within direct range of the USB-Koordinator 

5 Range of the USB-Koordinator 

Figure 71: devices within direct range of the USB-Koordinator 

 

1 2 3 4 5 
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The lower section of the Network information tab serves to measure various parameters of the wireless network. These measurements are 

useful for troubleshooting. If a measurement is necessary, the distributor will carry it out or ask you to do it and communicate the results. 

Start the measurement with the button Measure 1 Minute, Measure 10 Minutes or Measure 1 Hour. 

Before a measurement over 1 hour is started, set the logout time on the Email tab to never and complete the change with 

Save System Data. 

Table 27 lists the fields in the lower section of the Networf information tab and explains their function. 

Field Function 

Packets from directly 

connected nodes 

Number of wireless packets per minute from devices within direct range of the USB-Koordinator. This 

measurement’s colour symbol turns yellow or red if too many devices are in direct range of the USB-

Koordinator. 

Total requests received Total number of requests per minute sent from devices to the automatic test system 

Association requests 

received 

Number of requests per minute from devices which aren’t already registered in any system 

Heartbeats received Parameter of the wireless network 

Total requests send Number of requests per minute sent from the automatic test system to the devices 

Total request error rate Percentage of requests, which cannot be transmitted to the devices 

USB error rate Percentage of requests, which cannot be transmitted via the USB connection to the USB-Koordinator 

Table 27: fields in the lower section of the Network Information tab 

  

Figure 72: Network Information tab, installer user level 
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5.13 Distributor tab 

To view the Distributor tab, click on the Distributor tab in the tab bar. The Distributor tab is only available on the distributor user level.  

The distributor’s contact details and company logo are entered on the Distributor tab. In addition other general system settings are located 

on the Distributor tab. Figure 73 shows a screenshot of the Distributor tab. 

Table 28 lists the fields on the Distributor tab and explains their function. 

Field Function 

Company, Contact person, 

Phone, Email 

Distributor’s contact details.  

Logo Company logo that is displayed between the menu bar and the tab bar. If no distributor logo is loaded, the 

WirelessProfessional logo will be displayed. Figure 73 shows the Distributor tab with the distributor’s 

logo. 

Click on the Search button to open a dialogue window and select the logo file. The logo will be displayed 

after the Save System Data button has been clicked. Click on the Reset button to change back to the 

WirelessProfessional logo. 

Maintenance notification The WirelessProfessional software displays maintenance signals according to the maintenance time 

intervals set. The maintenance tab is only accessible via the Help menu when Maintenance notification is 

selected. 

Next maintenance Date when the Maintenance Due window is displayed. Once maintenance is complete, the date for the 

next maintenance will be set according to the maintenance time interval selected. 

Maintenance interval Period of time between the completed maintenance and the next maintenance signal 

Maintenance password 

protected 

The password that must be entered in the Maintenance tab in order to complete the maintenance. The 

maintenance password is created automatically from the USB-Koordinator address by the 

WirelessProfessional software and cannot be chosen by the user. 

Maintenance plan 1-3 File paths of the maintenance plans and texts displayed of the links to the maintenance plans  

Send maintenance emails Sends emails with a reminder that the maintenance is due 

Reduced duration test The length of time taken to carry out the duration test can be reduced here from the full test time to 2/3 of 

the test time. 

Table 28: fields on the distributor tab 
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Table 29 lists the functions that can be accessed from the Distributor tab with the buttons. 

Button Function User level 

Acknowledge tests Deletes all entries of incorrect test results (duration test and functional test) out of the 

Alarm list tab. The incorrect test results aren’t removed from the inspection log and it is 

stated there that the acknowledge tests function has taken place. The relevant test for 

emergency luminaires with incorrect test results is displayed with an orange colour symbol 

in the luminaire's details window and the error is displayed as “acknowledged” if the 

mouse cursor is placed on the colour symbol. 

The function Acknowledge tests has the purpose of allowing the distributor to leave a 

customer's system without error messages if errors occurred during a duration test and 

were eliminated but the emergency luminaires must be charged for 20 hours before the 

next duration test can be started. 

Distributor 

Reset Invalid Devices Registers the firmware of invalid devices in the system. The error message  Device invalid is 

displayed if the firmware of a device already registered in the system is updated.  

Distributor 

Change Distributor 

Password 

Change the distributor’s password Distributor 

Reset Installer 

Password 

Resets the installer’s password to 2222 Distributor 

Save System Data Saves changes Distributor 

Table 29: functions on the distributor tab 

 
 
 
 

  

Figure 73: Distributor tab, distributor user level 
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5.14 Maintenance tab 
 

 

The Maintenance tab is only available via the Help menu or the maintenance notification. The entry Maintenance in the Help menu is only 

active if the distributor has activated the maintenance function. The Maintenance tab is available on the facility manager, installer and 

distributor user levels. Figure 74 shows a screenshot of the maintenance tab. 

 

 

 
 

To open the relevant maintenance plan, click on or touch the link Maintenance plan in English. The maintenance plan contains detailed 

instructions for the system’s maintenance. 

One element of the maintenance is the inspection of the relays of the IO-Boxes. The IO-Boxes in the system are listed in the IO-Boxes section. 

A double click or two touches on the entry of one IO-Box in the IO-Boxes section will open the device details window of this IO-Box. The relay 

to be tested can be switched using the  T  button in the configuration tab (refer to section 5.16.3). 

Using the Complete maintenance button, maintenance can be completed, the maintenance window is shut and the timer for the next 

maintenance date is set. The Complete maintenance button is secured with a password. In order to end the maintenance with the Complete 

maintenance button, enter the maintenance password on the left hand side of the Maintenance tab. 

 

 

 

 

 

 

 

  

Figure 74: Maintenance tab, installer user level 
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5.15 Activation 

Click on or touch a device twice in the Alarm List tab, the Groups tab or the Configure Groups tab to open the device’s details window. The 

Device Details windows vary according to the type of device. 

 

 
Figure 75: required activation 

 

The Device Details windows can be opened on all user levels but the entries can only be edited on the installer user level. Click on Help and 

afterwards Activiation. 

 

 
Figure 76: open activation menu 

 

Here is the current state of the system (standard delivery condition: 250 devices, 5 timers, 1 monitorable device) displayed and you have the 

possibility over a activation code to increase the number of remote facilitys that can be monitored, the number of usable timers and the 

number of remote systems to be monitored. 

Select the features you want to unlock by clicking in the circular area next to the corresponding option. Through the features to be unlocked 

you generate a request code under the point "Request activation code". 

Several features with a request code can be requested. 

Please send this code to your service partner. You will get the activation code with which you can unlock and use the requested features. 
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The button Copy to clipboard allows you to insert the request code manually, for example in an e-mail. By using the button Send Email…  the 

Request Activation Code is automatically sent to the e-mail address, which is deposited unter Distributor. With the button  Save as file…  you 

can save the Requst Acitvation Code as a text file. 

 

 
Figure 77: overview activation menu 

Note: Request- and Activationcode are just for this specific system valid and cannot be transferred to other systems! 

 

Now enter the activation code, which you received from your sales partner. 

Upon successful entry, you will receive the following message. 

 

 
Figure 78: Features successfully activated 

 

If you enter an invalid code, the following error message appears. 

 

 
Figure 79: Invalid activation code 

 

If your system is assigned to WirelessControl devices (devices until April 2016), a corresponding warning symbol is displayed in the 

activation menu. See Details for information on which devices comply with the WirelessControl specification. 

 

Note: If the list is empty, only the coordinator does not conform to the WirelessProfessional specification. 
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Figure 80: Overview WirelessControl devices 

5.15.1   14 Days Trial Version 
 

The 14 Day(s) Trial Version button unlocks all features of the WirlessProfessional for a period of 14 days. During this time you can test all the 

features for free. After the test time, all features that have not been unlocked are disabled. 

The activation menu gives you information about the remaining test time. 

 

Note: This activation is only possible once! 
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5.16  Device details 
 

Click or tap twice on a device in the tab error lists, groups or configure groups to open the device details window of the device. The device 

detail windows differ depending on the device type. 

The device detail windows can be opened on all user levels. However, the entries can only be edited on the user level Installer. 

 

 

5.16.1    Device details emergency luminaire 

 

The Device Details window for emergency luminaires allows the luminaire’s position to be entered and the operating mode to be changed 

between maintained and non-maintained emergency luminaire. The Device Details window shows the luminaires position on the floor plan, 

its address and the results of the last three tests. If you position the mouse pointer on one of the colour symbols, the test’s date and time as 

well as the test result are displayed. 

      

 

  

 

 

Figure 81: detail window emergency luminaire 

      

  

Device type Function 

Maintained 

luminaire 

Luminaire for constant lighting and in 

case of power failure of the general 

lighting 

Non-maintained 

Luminaire 

Luminaire for lighting in case of power 

failure of the general lighting 
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5.16.2 Device details repeater 
 

The Device Details window for repeaters allows the repeater’s position to be entered and the position on the floor plan and the device’s address 

are shown. 

 

 

5.16.3    Device details IO-Box 
 

The General tab of the Device Details window for IO-Boxes allows the IO-Box’s position to be entered and the position on the floor plan and 

the device’s address are shown. Additionally the current status of the mains supply and the switching status of the three outputs (K1-K3) and 

the two inputs (E1, E2) are displayed with the same colours as those of the indicators on the IO-Box. 

 

 
  

Figure 82: device details repeater 

Figure 83: device details IO Box, General tab 
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The inputs and outputs can be configured on the Configuration tab of the Device Details window for IO-Boxes. 

 
 

Select the buttons K2 or K3 on the Configuration tab to set up the IO-Box’s outputs 2 or 3. Figure 84 shows the Configure IO Box Output 

window. The Output State section of the window facilitates the selection of the event that triggers the output relay. Table 30 explains the 

events the user can select from. The Groups applying section allows groups to be selected in which the selected event must occur in order to 

trigger the output. If one of the events Energy Save / Activate, Fire Alarm or Disabled is chosen, the Groups applying section is inactive, 

because these events always affect the entire system. 

 

 

  

Figure 84: device details IO box, Configuration tab 

Figure 85: Configure IO Box Output window 
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Event Function 

Test Running Output is closed while a test is running 

Last Test Failed Output is closed if the last test was finished with errors 

Maintained Luminaires 

switched 

Output is closed if at least one maintained emergency luminaire is turned 

off 

Non-Maintained Luminaires 

switched 

Output is closed if at least one non-maintained emergency luminaire is 

turned on 

Luminaires Blocked Output is closed if at least one emergency luminaire is in remote inhibiting 

mode 

Energy Save / Activate Output is closed if all switchable emergency luminaires are turned off 

Fire Alarm Output is closed in case of a fire alarm at the corresponding IO-Box input 

Disabled Output is disabled 

Table 30: events that trigger the IO-Box’s outputs 

 

Output 1 (K1) always switches on the event Device Error and cannot be configured. The relay of output 1 drops out whenever a device reports 

an error. If the wireless connection between the IO-Box and the automatic test system is broken, the relay of output 1 is delayed by the time 

span Time to connection error for IO boxes. The time span Time to connection error for IO boxes can be set on the Installation/System tab 

(section 5.11.5). 

Using the  T -buttons in the configuration tab, the output relays can be checked. The  T -buttons are used to switch the relays of the 

corresponding outputs. Once the configuration tab is exited, the K1-K3 output relays return to switching status corresponding to the 

configuration of the respective output. 

Select the buttons E1 or E2 on the Configuration tab to set up the IO-Box’s input 1 or 2. Figure 86 shows the Configure IO Box Input window. 

In the Input Name field a name can be assigned. In the Operating Mode section, the action that is triggered by the input signal can be selected. 

Table 31 explains the actions in the Operating Mode section. The Logic Level section allows selection of whether the action is triggered by a 

high level (active-high) or a low level (active-low) at the input. In the Groups to switch section, the groups in which the selected action should 

be performed on can be chosen. If one of the actions Energy Save / Activate, Fire Alarm or Disabled is chosen, the Groups to switch section is 

inactive, because these events always affect the entire system. 

 

  

Figure 86: Configure IO Box Input window 
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Action Function 

Switch Maintained Luminaires Switches maintained emergency luminaires on/off 

Switch Non-Maintained Luminaires Switches non-maintained emergency luminaires on/off 

Start function test Starts a functional test 

Block luminaires Turns emergency luminaires into remote inhibiting mode 

Energy Save / Activate Turns all switchable emergency luminaires off / turns all 

maintained luminaires on 

Fire Alarm Turns all switchable emergency luminaires on 

Emergency mode 1h Turns selected groups for 1 hour into an emergency mode 

(not available in any regions) 

Disabled Input is disabled 

Table 31: Actions triggered by an IO-Box input 

 

5.17   Menus 

In the WirelessProfessional software, the menu bar is located below the title bar. In full screen mode, the menu bar is not displayed! You can 

switch between full screen mode and normal display mode with Alt + Enter. 

 

 

5.17.1    File menu 
 

Figure 87 shows a screenshot with the File menu folded out. Table 32 explains the entries in the File menu. The items Inspection Log, 

Communications Log and System Log have the same effect as the functions on the Alarm List tab.  

 

 

Menu item Function 

Inspection Log Opens the inspection log. See section 5.7.1. 

Operationtime Log Not implemented 

Communications Log Opens the communications log. See section 5.7.2. 

System Log Opens the system log. See section 5.7.3. 

Quit Application Closes the WirelessProfessional software 

Table 32: File menu 

 
  

Figure 87: File menu 
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5.17.2 Options menu 

 

Figure 88 shows a screenshot with the Options menu folded out. Table 33 explains the entries in the Options menu. 

 

 

 
 

Menu item Function User level 

Serial Port Manually set the USB-Koordinator’s port Anybody 

Start Function Test Starts a functional test on all emergency luminaires Facility manager, installer 

Start Capacity Test Starts a duration test on all emergency luminaires Facility manager, installer 

Put Message into Inspection Log Manually enter a message in the inspection log Anybody 

Login / Logout Login / logout as facility manager or installer - 

Toggle Fullscreen Changes to full screen mode Anybody 

Table 33: Options menu 

 
The emergency luminaire batteries must be fully charged in order for a functional or duration test to take place (refer to sections 2.2 and 2.3). 

  

Figure 88: Options menu 
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5.17.3 Help menu 
 

Figure 89 shows a screenshot with the Help menu folded out. Table 34 explains the entries in the Help menu. 

Menu item  Function 

Contact Shows the installer’s contact details 

Show Support 

Information 

Shows the USB-Koordinator’s address (Device number), the software’s build date and the installer’s 

and distributor’s contact details (Figure 90) 

Register Not implemented 

Perform maintenance Opens the Maintenance tab. The Perform  maintenance entry is only active if the distributor has 

activated the maintenance function. 

About Shows the software version, the build date and the manufacturer 

Table 34: Help menu 

 

 

 

 

 

Figure 89: Help menu 

Figure 90: Send Support Information window 
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6 Additional software 

WirelessProfessional systems are delivered with additional preinstalled software. This software fulfils different functions in the 

WirelessProfessional system. Table 35 displays an overview of the additional preinstalled software. 

For some of the software preinstalled on the computer it is necessary to obtain a license in order to be able to use the software. 

It is possible to operate a WirelessProfessional system from another computer using the VNC Server and Teamviewer Host software. The 

software transfers the screen content of the WirelessProfessional PC onto another computer from which the system can be operated. The 

respective Client software for the remote desktop connection must be installed on this computer (refer to Table 35). 

Software Function License 

VNC Server Remote desktop software for local network connections. Client’s 

download (VNC viewer) from https://www.realvnc.com/download/ 

Server: Licence required, 

www.realvnc.com 

Client: no license required 

Teamviewer Host Remote desktop software for internet connections. 

Client’s download (Teamviewer All-in-one) from 

http://www.teamviewer.com/de/download/index.aspx 

Server (Host): No license required 

Client: license required, 

https://www.teamviewer.com/de/ 

Cobian Backup Backup software. Periodically saves the inspection log, communication 

log and system log. 

No license required 

TigerVNC Server With TigerVNC Server a desktop vnc (virtual network computer) is 

starting. It starts Xvnc with the respective options and starts a window 

manager on the vnc desktop. 

No license required 

TigerVNC Viewer TigerVNC Viewer is a viewer (client) for virtual networking computing. A 

remote desktop software for connections in a local network. 

No license required 

Table 35: Additional preinstalled software 

 

  

https://www.realvnc.com/download/
http://www.realvnc.com/
http://www.teamviewer.com/de/download/index.aspx
https://www.teamviewer.com/de/
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7 Networking of systems 
 

The following section describes how to configure the TigerVNC Server. 

 

Note: If TigerVNC Server is not installed, it should be installed. 

The WirelessProfessional software package includes the TigerVNC Server. 

1.) Start “Configure VNC Server” via the startmenu 

 

 
 

2.) Via Configure you can set a connection password. 

 

 
Figure 91: TigerVNC Server settings 
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3.) In the menu point “Accept connections on port” change the port to 5901. 

 
Figure 92: TigerVNC Server connections 

 

4.) Confirm with Ok   

5.) Start „Run VNC Server“ via the start menu. This shortcut must be stored in the autostart, so that the TigerVNC server is started 

automatically with Windows. 

 

Windows 10 

a. Press the key combination “Windows-key + R” 

b. Enter the command “shell:startup” and click OK 

c. The autostart folder will open automatically 

d. To start a new program in the autostart, click on the Windows icon in the bottom left-hand corner of the taskbar and find the 

desired program in the list. Then simply drag the entry into the startup folder via "drag & drop" 

e. Windows will automatically create a shortcut to the program you selected. At the next system start this program will be loaded 

automatically 

 

 
6.) There is a new icon for the TigerVNC in the task bar and it indicates that the server is running. 
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7.1.1 IP address 
 

For the Wireless Professional software to monitor another device via Ethernet, it is necessary that there is a network connection between the 

devices. 

 

To set up the network adapter properties, admin rights are required on the system. If you do not have one, contact an administrator or 

distributor. 

 

If the monitoring device is not in the same IP address space as the device to be monitored, a corresponding route from one IP address space 

must be routed through a gate to the other address space. 

 

The network route is set up in the operating system. Please contact your administrator. 

 

A device to be monitored can be addressed by the Wireless Professional software with both the DNS and the IP address. In order to be able to 

respond via DNS, the name server must be entered in the network configuration. 

 

The establishment of the DNS takes place in the operating system. Please contact your administrator. 
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8 Troubleshooting 
8.1 During the installation process, a device’s address is not shown in the Unknown nodes section 

Check the following in the given order: 

1. Check if the device is connected to the mains supply (emergency luminaires: is the charge-indicator lit? IO-Box: is the green indicator 

lit?) 

If the mains supply is connected: continue with no. 2 

If the mains supply is not connected: connect the device to the mains supply 

2. Check if the device is sending a wireless signal. Put the USB-Koordinator together with the Computer and the WirelessProfessional 

software next to the device. Check if the device’s address is displayed on the Network Information tab. 

If the device’s address is displayed on the Network Information tab: continue with no. 3 

If the device’s address is not displayed on the Network Information tab: contact the distributor 

3. Check if the device’s address is displayed in the Unknown nodes section, when the USB-Koordinator together with the Computer and the 

WirelessProfessional software is run next to the device. 

If the device’s address is displayed in the Unknown nodes section: presumably the wireless connection with this device is broken, 

because the distance between devices at one or multiple positions is too large. 

If the device’s address is not displayed in the Unknown nodes section: the device was not recognized by the system. Manually add the 

device and register the device in the system. Afterwards delete the emergency luminaire from the system and from the Unknown nodes 

section. The device should now show up automatically in the Unknown nodes section. 

8.2 There are Device invalid entries in the Unknown nodes section 

The WirelessProfessional software reports invalid devices if it does not recognise the device’s firmware version. This is typically the case when 

new devices with a later production date are added to an existing system. Contact the distributor to update the WirelessProfessional software. 

8.3 After start-up of the WirelessProfessional software, the system stays in the Status is being updated state 

The larger of the two time spans Time to connection error and Time to connection error for IO-Boxes determines the minimum time which the 

automatic test system displays the Status is being updated (colour symbol ) message at start-up. The values for Time to connection error 

and Time to connection error for IO boxes can be set on the Installation/System tab (section 5.11.4). 

8.4 The facility manager’s password is lost 

The facility manager’s password can be reset to 1111 by the installer or the distributor. The facility manager’s password is reset on the 

Installation/System tab. 

8.5 The installer’s password is lost 

The installer’s password can be reset to 2222 by the distributor. 

8.6 Exchange USB-Coordinator 

1. Disconnect the USB coordinator from the PC by unplugging the USB coordinator from the USB cable. 

2. In the software under Installation → System, click the Reconnect All Devices button (see Figure 70). 

3. Exit the software. In the upper left of the software, under File, click Exit program and confirm the following message with OK (the 

USB cache will be deleted). 

4. Restart the software. 

5. Connect the new USB coordinator to the PC 

6. Then connect to the software by selecting the serial port (see section 3.3). 

Note: After connecting to the coordinator, Wireless Professional Software will automatically reassociate all devices by disassociating and 

then reassociating the devices one by one. 
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9 Glossary 

automatic test system (ATS) 

automated test system that may be manually initiated, consisting of parts (such as timers, current detectors, light detectors, changeover 

switches) which, when connected together, make a system that can carry out the routine testing requirements of emergency lighting 

luminaires, and indicate the test results (EN 62034:2012) 

duration test 

test to check if the battery emergency power supply source supplies the system within the limits of rated duration of emergency operation (EN 

62034:2012) 

emergency follow-up time 

time span during which the emergency luminaires stay turned on after the signal at the fire alarm input has become inactive 

emergency lighting 

lighting for use when the supply to the normal lighting fails; it includes emergency escape lighting, high-risk task-area lighting and standby 

lighting (CIE publication 17.4, EN 60598-2-22:1998 + A1:2003) 

emergency luminaire rated luminous flux 

lumen output as claimed by the luminaire manufacturer 60 s (0.25 s for high-risk task-area lighting luminaires) after failure of the normal 

supply, and continuously to the end of rated duration of operation (EN 60598-2-22:1998 + A1:2003) 

emergency mode 

state of a self-contained emergency luminaire that provides lighting when energized by its internal power source, the normal supply having 

failed (EN 60598-2-22:1998 + A1:2003) 

fire alarm 

IO-Box input configuration. If the signal at the fire alarm input is active, all switchable emergency luminaires are turned on.  When the signal 

at the fire alarm input becomes inactive again, the emergency luminaires stay on for the emergency follow-up time and will only then be turned 

off. 

functional test 

test to check the integrity of the circuit and the correct operation of a emergency luminaire, a changeover device and a battery emergency 

power supply (EN 62034:2012) 

maintained emergency luminaire 

luminaire in which the illuminant is energized at all times when normal or emergency lighting is required (EN 60598-2-22:1998 + A1:2003) 

masking 

A function of the WirelessProfessional Software, that suppresses error messages from masked devices. Masked devices can be identified as 

being masked on the Configure Groups tab. 

non-maintained emergency luminaire 

luminaire in which the illuminant is in operation only when the supply to the normal lighting fails (EN 60598-2-22:1998 + A1:2003) 

normal mode 

state of a self-contained emergency luminaire that is ready to operate in emergency mode while the normal supply is on. In the case of a 

normal supply failure, the self-contained luminaire automatically changes over to the emergency mode (EN 60598-2-22:1998 + A1:2003) 

normal supply failure 

condition in which the normal lighting can no longer provide a minimum illuminance for emergency escape purposes and when the emergency 

lighting should become operative (EN 60598-2-22:1998 + A1:2003) 

rated duration of emergency operation 

time, as claimed by the manufacturer, that the rated emergency lumen output is provided (EN 60598-2-22:1998 + A1:2003) 

remote inhibiting mode 

state of a self-contained emergency luminaire which is inhibited from operating by a remote device while the normal supply is on and in case 

of a normal supply failure the luminaire does not change-over to emergency mode (EN 60598-2-22:1998 + A1:2003). The remote inhibiting 

mode is only allowed during shutdown periods. Only switchable emergency luminaires can be turned into remote inhibiting mode. If the 

emergency luminaire’s wireless connection to the automatic test system is broken, the remote inhibiting mode is cancelled after 15 min. 

Emergency luminaires in remote inhibiting mode cannot be tested and also remain switched off if a fire alarm occurs. 

self-contained emergency luminaire 

luminaire providing maintained or non-maintained emergency lighting in which all the elements, such as the battery, the illuminant, the 

control unit and the test and monitoring facilities, where provided, are contained within the luminaire or adjacent to it (that is, within 1 m 

cable length) (EN 60598-2-22:1998 + A1:2003) 
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